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1 General

SetEdit21174 is a program to change the settings (program sequence, names of channels etc.) of the
Medion 21174 digital satellite receivers.

You can easily make your own channel lists, edit them, print them and write them into your receiver.
You can enter new channels or new transponders, edit, delete and save them, change the names of
channels, sort, search, copy and paste channels.

With SetEdit you can edit settings of different receivers, exchange channels between settings files of
different receivers or convert a settings file of one format into another (e.g. SetEditDVB2000 into
SetEdit21174).

You also have the possibility to create a personal wish list for your settings and then adapt any
settings file (if you have got the corresponding SetEdit full version) to this wish list and write it into the
receiver.

The settings are read from the receiver and written into the receiver with a USB stick/drive.
In the following guide you will find a step by step description of how to use this program. In the other

chapters there is a short description of all functions divided in file, channel, satellite, transponder and
favourite list functions and the configuration.



2 Installation

System requirements:

PC with Windows NT/2000/XP/Vista/Win 7, an USB interface and 20 MB of free disc space. You also
need an USB stick or drive.

First Installation:
If you like to install SetEdit for the first time, please start the file SetEdit21174_installation_en.exe.
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Start Menu shortcuts
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(] show SetEdit21174 directory
Launch SetEdit21174

In this window you can select, if you get in addition to the program a desktop shortcut and an entry in
the start menu. Furthermore you can select that after the installation SetEdit is launched and/or the
SetEdit directory is shown in the explorer.

When you click on "Next", you can select the installation directory.
The installation contains the program itself, some pictures and a sample settings file.
There are no changes made to the Windows system files.

You will also find the file SetEdit21174.ini in this directory. Your personal configuration is saved in this
file.

If you have more than one receiver (with the right DLL modules), you can decide with which type of
SetEdit the program should start. You just have to change the name of the exe file. Example: If you
start SetEdit21174.exe after the installation of SetEdit21174 _installation_en.exe the program will start
as a Medion 21174 editor. If you change the name of the SetEdit21174.exe file into
SetEditDVB2000.exe, the program will start as DVB2000 editor. Of course you can open additional
SetEdit21174 if required.

Add other editors:

With SetEdit you can convert all settings formats that are supported by SetEdit and for that you have
got the corresponding editor (in form of a DLL file) into any other supported format.

In the following example | assume you have already installed a Topfield editor and want to add a
Humax editor

To add the Humax editor to your already existing Topfield editor, you have to select the Humax
receiver on my homepage
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Here you can download the upgrade in form of a zip file. (You can either start the installation
immediately or save this file on your hard disc first.)
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Extract the zip file and enter the directory of your Topfield installation as destination directory. You can
also drag the files with drag&drop to this directory.

You can open this directory, if you click on the help button in the main program and then select "Open
SetEdit directory" from the popup menu.
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The Humax DLL file and the Humax documentation now appear in your SetEdit directory.

Now please close all SetEdit editors and restart the program.

Note: to convert a settings file into another SetEdit format, you have to buy the corresponding license

first.

Deinstallation:

To uninstall SetEdit21174 simply delete all files, which are in your SetEdit directory.




3 Step by step

| assume that the program has been installed on your PC as described in chapter 2.

Also it is assumed that you are using SetEdit21174 for the first time. In the following | will describe how
to transfer the settings from the receiver to the PC and back (chapter 3.a and 3.e). By means of
examples you will see how to get order in your settings (chapter 3.b), how to put channels into the
favourite list (chapter 3.c), how to work with the transponder menu (chapter 3.g), how to enter new
channels by hand (chapter 3.g), how to handle the peculiarities of German Premiere World channels
(Formula 1, soccer, pay-per-view) (chapter 3.g) , how to adjust settings from other receivers (chapter
3.h and 3.i) and from DXAndy (chapter 3.j) to your requirements and how to convert one settings
format into another (chapter 3.i) , how to create a personal wish list and then adapt settings to this
wish list (chapter 3.k).

3.a Load and back up a settings file
Read settings from the receiver:

Please connect your USB stick or your USB drive to your receiver.

Click in your SetEdit window on "File" -> "Read from receiver". You get a message which tells you how
to transfer the settings from your receiver to the USB stick/drive.

Than please connect the USB stick/drive to your PC.

Now you can load the settings file with "File" -> "Open".

Save settings:

To save your settings, please click again on the button "file" to open the file menu but now select the
function "Save as". You get the following dialogue:

Here you have to enter the directory and filename of your back up.
As soon as you have clicked on "Save" in this dialogue, the data is saved in this file.

If you make some unintentional changes in your settings when you experiment with SetEdit21174 you
can always restore this backup file into your receiver and reverse any changes.

Now you can change your own settings file, which is already visible in SetEdit21174, or you can adapt
a settings file from your hard disc (e.g. from the Internet) to your own requirements and write it into
your receiver (chapter 3.h and 3.i).

Load a settings file from your hard disc:

If you want to adapt a settings file from your hard disc (e.g. from the Internet) to your own
requirements and then write them into your receiver, you have to load these settings first. Please click
on the button "File" and then select the function "open" from the file menu.

Now please select the file you want to load from the list you see
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and click on "Open" or double click on the file you want to load.

Note: If you want to write settings that you have found in the Internet into your receiver, you have to be

careful:

A settings file does not only contain the channel information, it also includes the LNB and the satellite
configuration. These configuration settings will usually not fit to your receiver.

Therefore you should better overwrite these configuration settings with your own configuration settings
(see chapter 3.i or 5.d.)

When you have loaded a settings file or read the settings from your receiver, you get the following
window (depending on the window size and some personal settings the picture may differ).
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You see the TV channels (light blue background) and the radio channels (light green background) as
well as a transponder list, a satellite list and the favourite list (FAV).

If you select an item in the satellite list, you will see all channels and all transponders that are assigned
to this satellite.

If you select a transponder or the favourite list, you will only see the channels that are assigned to this
transponder or the favourite list.

When you select a channel, the satellite, transponder and FAV list (if the channel is in the FAV list) of
this channel are marked grey.

Channels that are in the favourite list are marked in the channel list with a darker background colour.
Transponders marked in red are empty; they contain no channels.

If the channel number is marked with a red background colour, the channel is assigned to a vertical
polarised transponder. If the channel number has a white background colour, the channel is assigned
to a horizontal polarised transponder.

If a satellite has a green background colour, it is activated, which means there are already channels on
this satellite.

(You can change all these marking colours in the configuration menu, see chapter 5.b.)

When you click with the right mouse button in the channel list (TV or radio) and select from the popup



menu the entry "Info" you will get the number of TV channels, radio channels, transponders and
satellites that are in your settings.

SetEdit21174

You have:

T% channels: 1964
Radio channels: 333
HD Channels: 232
Scrambled: 1133
Skipped: 2

F& channels: 3
Extra O

Urwwanted: 0
Satelites: 61
Tiansponders: 1357 (2992)
Total: 2363 (5000]

Selected:0




3.b Arrange settings

Now you have the settings (from your own receiver or from the Internet) in SetEdit21174.
The most important functions will be explained now in detail with some examples, while in the chapter
functions all functions are briefly described.

The most important function of SetEdit21174 is to get order in your channel list. This can be by
deleting channels you don't need (e.g. channels that are scrambled and you have no subscription for),
getting the channels into a useful order, assigning the channels to the favourite list and correcting
wrong channel settings (e.g. wrong channel names).

First let us suppose that we want to delete a channel. To do this we have to select the channel first.
Please click with the mouse on the channel. Then the satellite, the transponder and the FAV list (if this
channel is in the FAV list) of this channel are marked grey in the respective list.

Sometimes it is useful to change this colour (similarly for other colours, for example the colours used
for new channels (for the import) or duplicate channels), e.g. because the colours are too pale on a
laptop. You will find a description how to do this in chapter 5.b.

Now click with the right mouse button in the channel list and open the channel menu:
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Please select the item "delete" in this menu and the selected channel will be deleted from your
settings.

If you delete a channel within the favourite list, this channel is only removed from the FAV list but not
deleted from the main list.

Note: There is no undo function yet, so be careful.
To delete a channel, you can also select the channel and then hit the Del key on your keyboard.

To delete multiple channels please click for example on channel 5, then press the shift key and keep it
pressed and then click on channel 7. The channels 5 to 7 are now selected. Now you can delete these
channels as described above.

To select channels that are not consecutive (e.g. the channels 5, 20 and 39) please click on the first
channel (here channel 5), then press the Ctrl key on your keyboard, keep this key pressed and then
click on the other channels you like to delete.

Now assume we want to move a channel, e.g. ZDF to position 2.

Note: You can show your channel lists in original order or sorted by alphabet, frequency or polarity.
Moving channels is easier when the channel list is shown in its original order. If the channel list is
shown in alphabetical order and you move a channel, only the channel number will change but not the
position of the channel in the channel list (the name is still the same). To show the channel list in



original order, please click with the right mouse button into the channel list and select from the menu
item "View sorted by" the option "Original".

2 w(Original Shift+alt+0
Mames [alphabetic) Shift-+2le+
Frequency Shift+al+F
Polarity Shift+alt+P

Change data Fetun
Delete Del
Coou Cirl+C

To change the viewing mode of the channel lists you can also click on the letters "O" (original), "N"
(Name), "F" (frequency) or "P" (polarity) in the border of the channel lists.

First we have to find out the position of the channel ZDF at the moment. To find all channels you first
have to click on the satellite "all" to see really all channels, independent of the satellite the channels
belong to. Then you can search for ZDF by entering the first letters of the channel name. Please click
anywhere in the channel list and hit the "Z" key on your keyboard, now all channels whose names
begin with "Z" are selected. Now hit the "D" key on your keyboard. Now all channels beginning with
"ZD" are selected. You can do this of course with the third, fourth letter etc. If you wait for more than
three seconds between two letters a new search is started, so that the last letter entered is taken as
the first letter of the name that is searched.

You can also use the "find channels" function to find channels by name. Open the channel menu and
select the function "find channels" from this menu. You will get this window:
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You can choose whether you want to search on all satellites or only on the actually selected satellites.
Click on the field beneath "all satellites" to search on all satellites (if you have selected "all" in the
satellite list you won't see this option because all satellites are searched anyway).

If you now enter "ZDF" in the field "Name" you will see in the list above all channels whose names
begin with "zdf", e.g. the channel ZDFtheaterkanal.

If you click on the white square to the left of the text "substring” you will see all channels that include
the entered letters as a part of the channel name (beginning, middle or end, upper/lowercase is
ignored). If you enter for example the word "sport" the channel "Eurosport” is found too.

Now you can move channels from this list to another position in the channel list or assign them to
another satellite, transponder or the favourite list. The channels will not be removed from the find list,
but when you click on such a channel you will see that the new satellite, transponder or the favourite
list is now marked in grey.

Within this find function you can also delete channels. Simply select the channel in the list of the find
function and hit the Delete key on your keyboard.

Now you have found for example ZDF. There are several ways to move the channel.

The first way is to move the channel by drag & drop: click with the left mouse button on the channel
you want to move, keep the mouse button pressed and drag the channel to the position you like to
have it. The channel will be placed in front of the position the mouse is on.

To drag a channel on the last position in the list, you have to drag it behind the last channel.

You can also move the channels with the arrow keys of your keyboard. Please select the channel(s)
you want to move, then press the Ctrl-key on your keyboard and keep this key pressed. Now you can
move the selected channel(s) with the arrow keys on your keyboard. If you press the key "Home" or



"End" while the Ctrl key is pressed you move the selected channel(s) to the beginning or the end of
the list.

With both methods described above you can move of course more than one channel.

Another possibility is to move a channel directly to a position (e.g. channel 20 to position 5). Please
select the channel, then click with the right mouse button in the channel list and select from the
channel menu you get the function "Move to", the following dialogue appears:

Channel number

Moveto

E—
oK. Cancel

Here you can enter the channel number you like to move the selected channel to (in this example 5).
The selected channel will be moved now in front of the channel that was previously at this position.
If for example KABEL1 had a channel number higher than 5 before, it will be moved to channel 5. If
the channel had a lower channel number before (e.g. 3) the channel will be moved in front of the
channel that was at position 5. Because one channel is now missing in the list (the channel you are
moving) all channels are moved up one position (i.e. to lower numbers), so in this case your channel
will be moved to position 4.

Especially if you use the drag & drop method it is often a problem that not all channels can be seen on
the screen, so you have to scroll. If you want to move a channel from position 500 to 10 you have to
keep the mouse button pressed while you move to position 10. If you move the mouse some pixels up
and down at the border of the list, then the list will scroll in this direction.

There are some functions that make moving channels more comfortable. For example you can hide
one of the lists (TV or radio) to have more space for the channels. You can even hide the satellites,
transponders, the favourite list and the data window. Please call the channel menu and select on
"Show" what you want to see (TV, Radio, TV and Radio, "Show only channels" or "All lists").
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If you double click on the name of a channel list the other list will be hidden.
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With a second double click on the name you will see both lists again.
When you click on the letter "C" in the border of the channel lists, the satellites, transponders, the

favourite list and the data window are hidden. When you click on the letter "A", you will see all lists
again.

Another function that makes moving by drag & drop easier is the "split" function. Please click with the
right mouse button in the channel list to open the channel menu and select the function "Split" from the
popup menu.
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All channel lists (depending on what is shown/hidden) are now shown twice. It is of course the same
list, but you have two different views of it. Changes in one of these lists will affect the other list too.
You can move channels from the upper list to the lower list, because it is the same list but from
different points of view, the entry is changed in both windows.

If you make many changes to the channels, please remember to save from time to time. To do this hit
the "file" button. From the file menu please select the item "save" to save the file. If you want to keep
your original file and save the file with a different file name, you should use the "save as" function in
the file menu. Enter the file name and click on the "save" button.

With the function "Sort" in the channel list menu, you have several possibilities to sort the channels.

Sort by alphabet
Compact channel list Sort by frequency
DISMEY CHAMMEL -» Dizney Channel Al Sort by Service 1D

Find channels Cl+F Sort by polarity

Fird dunlicates kD Sort channel list by S atellites

Contrary to the function "View sorted by" the channels are not only shown in a different order, they
also get another channel number. You can sort the complete channel list by satellites. This may be
helpful if you have got a motorized dish. If you have sorted your channel list by genres for example,
your dish would always move between the different satellite positions, when you zap in your channel
list.

If you want to sort channels alphabetically, by frequency or polarity, you first have to mark the
channels you want to sort.



3.c The favourite list

The Medion 21174 receivers have one favourite list for your favourite channels.

To assign one or more channels to the favourite list simply move the selected channels by drag & drop
on the name of the favourite list.
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To remove one or more channels from the favourite list you first have to select the FAV list you want to
remove channels from. Then select the channels you like to remove and select "Delete" from the
channel menu or hit the "Del" key on your keyboard.

When you delete channels from the favourite list, the channels are only removed from the favourite
list, but not from the main list.

You can also use the "Mark as" function of the channel list menu to assign one or more channels to
the FAV list or remove it/them from the FAV list.

Channels that are in the favourite list are marked in the channel list with a darker background colour.
To change this colour please see chapter 5.b.

You can't change the order of the channels in a FAV list independent of the order of the channels in
the main list.

With the "export" function in the popup menu of the favourite lists you can save a favourite list to your
hard disc.

With the "import" function you can ad this favourite list to another settings file. If there are one or more
channels in the favourite list which haven't been in the settings file before, these channels and the
corresponding transponders will be added.



3.d Channel parameters

To rename a channel (e.g. "Das Erste" to "ARD") please select the channel and choose from the
channel menu the function "change data" (or double-click on the channel), then you get the channel
data menu:

Change channel data

ServiceType NetID
[Ty =l

PCR PID Frequency T5ID

[28721 [101 [230.000 [1051

Videa PID——-Audio PID

101 02

FMT PID FiDs Symbol rate

[100 [Dec -] | [cam0

I~ serarbled

I~ skipped

[~ deleted

I~ HD

[~ extra

[~ urwanted

Cancel oK

In the field "Name" you can now enter the name of the channel.

Furthermore you can change the transponder data (frequency, polarity, symbol rate, Net ID and TS
ID), the PIDs and the Channel ID of the channel (see chapter 3.9).

For some transponder types these boxes will change. E.g. for DVB-C (cable) transponders there is no
FEC and no polarity, but you have to enter the modulation.

With "PIDs" you can choose whether the PIDs are shown decimal or hexadecimal.

You can also mark channels as "scrambled", "deleted", "skipped", "unwanted" or "extra" within this
menu or remove these markings.

A skipped channel is marked with an X and is skipped when you zap with the arrow keys, you can
enter it directly in the receiver channel menu or by entering the channel number. Scrambled channels

are marked with the following symbol:
§

Note: If you remove the scrambled symbol this does not mean that the channel can be watched for
free. This is just the marking of the channel.

If you mark a channel as unwanted, this channel will be shown in the channel list with a grey font and
will be marked with a red minus. Extra channels will be marked with a red plus.
You need those markings (Extra and unwanted) for the wish lists functions (see chapter 3.k).

Caution: If you save a settings file, all unwanted channels and transponders are deleted. And the
markings for extra channels will disappear too.

In the field "Service Type" you can change the type of the channel (TV, radio or HDTV).
HDTV channels are marked with "HD" in the channel list.

Note: Channels that have the service type "TV channel" or HDTV channels only appear in the TV list,
"Radio channels" only in the radio list.

With the function "mark as" from the channel list menu you can change the following properties for
more than one selected channel at once. You can:

-Mark channel(s) as "(not) skipped", "(not) deleted" or "(un)scrambled"

-Assign channel(s) to a service type

-Assign channel(s) to the FAV list or remove it/them from the FAV list

-Mark channel(s) as "(not) linked", "(not) unwanted" or "(not) extra" (wish lists)

-Mark the transponders or the selected channels with all their channels as unwanted (wish lists)



Mark new channels in b unscrambled
Femaove new channel markings skipped
Mark not existing channels in 3 nat skipped
Femave nat existing channel markings deleted Alt+Del
Sart b notdeleted Shift+at+Del
Compact channel list FAY channel
DISNEY CHANMEL -» Disney Channel Al no F&Y channel
Find channel: Chil+F Ilnke.d
Fird duplicates O | otlinked
Hew oy | PO '
Service type 3
v Split Chrl+T
exlia
ot exira
unwanted Chrl+lt+k
not unwanted Shift+Alt+k,
TP of thiz channel urwanted Crl+alt+T

Many channels are only shown in uppercase letters. To change this, you don't have to enter a new
name for each channel. Simply select the channels whose name you want to change and select the
function "DISNEY CHANNEL -> Disney Channel" from the channel menu.

The first letter of the individual words is never changed by this function. If mixed upper/lower case
letters occur in the word, nothing is changed (example: EinsMuXx). Words with less than 4 letters are
also not altered, so that abbreviations such as CNN stay unchanged.

In the file SetEdit.ini there are lists of exceptions (which can be changed) to these rules. There is a list
of 10 words that are not converted although they contain more than 3 letters, (example: ESPN, CNBC)
and a list of 10 words that are converted although they are shorter than 4 letters (example: "CO" so
that from KRIMI&CO you get Krimi&Co).

The reasons why you might be interested in changing the channel names to lower case are that
mixed-case writing is easier to read and lowercase letters are often narrower than uppercase letters,
so that when you have more lower case letters in the channel name more letters can be shown in the
channel list of the receiver. Channel names that do not fit within the channel list are truncated.



3.e Write settings into the receiver

When you have finished making your personal settings you have to write them into the receiver before
you can use them. To do this, please click on the button "File" and select the function "write into
receiver" from the file menu.

You get the following message:

SetEdit21174

The settings are saved as:

clooocd DATABASE. bin

Please copy this file to an USB stick. Then connect the USB stick

to your TV and select "Meni” -= "Lock” -= "Hotel Setup” -» "Database Import”
- "Right arrow”,

Please follow the instructions in this message to transfer the settings into your receiver.

Note: If you have used the wish list functions there may be some specials to take care about. Please
read chapter 3.k.

3.f Print or export settings

You can print your settings. To do this click on the "File" button and select from the file menu the
function "Print". You get the following dialogue:

. Print @
Sort
¥ Channelnumber (~ Transponder
Channels:
& i € Selected
[~ Onty unskipped
Print
[~ Frequency [~ Channel D
[v Polarity ¥ vPID
[¥ Symbol rate v APD
[v PCRPID
[~ Scrambled
[~ Satelite [~ FAV
Font height:
4 mm - Cancel Print

First you have to select if your printout should be sorted by channel numbers or by transponders
(frequencies).

If you print your channels in number sequence, you can also select whether you want to print all
channels, only the selected ones or only the unskipped channels.

There are some options. You can choose if you also want to print the frequency, the satellite, the
PIDs, if the channel is scrambled or if the channel is in the FAV list, etc.

Finally you can enter the Font height for your printout. Then please hit the button "Print". A printing
dialogue will appear, whose layout depends on the printer you have installed.

With the "export" function you can export your settings to a plain ASCII file that can be opened with
Word or Excel or other applications. The tab character (0x09) separates the different parameters.

Besides this the export works the same as printing. Select "Export" in the file menu, then you select
the optional parameters as described above and click on the button "Export".

You get a window where you can enter the filename and select the directory of the exported file.



3.g Using the transponder functions and entering new channels by hand

There is a short summary of the transponder functions in chapter 5.e.

Possibly when you read the settings from your receiver you wondered about channels with strange
names and that some channels were missing in your list (e.g. German Premiere, soccer, Formula 1 or
pay-per-view channels).

Channels that share place (like the German ARTE/Kinderkanal) can only be found in the receiver if
they are active at the time you make the channel search. Some of the Premiere Direkt, soccer and
Formula 1 channels are found, but not with the right name.

In the following you find a description how to enter new transponders (and channels) and how to
change wrong transponder data.

In the Internet there are sites (e.g. www.lyngsat.com) where you can find all channel settings
(including the missing pay-per-view or soccer channels). In the following you find an explanation how
to enter channels and transponders from such lists by hand.

Suppose you discover on www.lyngsat.com that on satellite X a new transponder is active, but your
receiver can't find this transponder at the moment, for example because it does not send at the
moment (feed) or your antenna is not aligned to this satellite.
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Here we see that transponder 12656 horizontal is new and one scrambled TV channel (Anem, the
orange background shows you that the channel is scrambled) and two audio channels (B2-92 with two
different audio PIDs) are active on this transponder.

Now you have the possibility to create a new transponder first and then enter the channel on this
transponder. Or you can directly enter a new channel with the right transponder data on the satellite.
Both methods may be useful, so both will be described in the following:

To create a new transponder, you first have to select the satellite of this transponder. Then you click
with the right mouse button in the transponder list and select in the transponder menu the function
"New" -> "Transponder". You see the following window:

Change transponder data

Frequency Met D

oo ) R

TS ID:

0
Symbol rate:

N Cancel

[~ unwanted

For the example mentioned above you enter 12656 for the frequency and HOR for the polarity. The
symbol rate in this case is 2963. The FEC (in this example 3/4) is not used in SetEdit21174.

The green numbers in the Lyngsat chart are the NETwork ID and the TS ID (here NET ID=0and TS
ID =176).

These two IDs identify the transponder. The Net ID identifies the provider; the provider sets the TS ID
in any way he likes. If a provider has more than one transponder on one satellite, the Net ID is always
the same and the TS ID differs.

Please confirm with OK then you will find the new transponder at the end of the transponder list.

Note: Some boxes are only visible for certain transponder types, e.g. "Pilot" for DVB-S2 transponders.



Now you can enter the new TV and radio programs on this transponder.

To do this select the new transponder and click with the right mouse button in the now empty channel
list and select the function "new" from the channel menu you get. You get the following window:

Change channel data

Name ServiceType NetID
[ i || i3z
Ch. D PCR PID Frequency TS 1D
o o |a62 000 E]
Video PID Audio PID

0 0 E

PMT PID PIDs Symbal rate

[o [Dec -] | [raon

[ scrambled
[ skipped
[ deleted
[~ HD

[ extra

[ urwanted

Cancel oK

You can also click with the right mouse button in the transponder list (the new transponder has to be
selected too) and with "New" you can select the function "TV channel on this transponder” or "radio
channel on this transponder".

You will get the same window.

The correct transponder is already entered.

If you want to enter a channel directly, please select the satellite for this channel, click with the right
mouse button in the channel list and select the function "New" from the menu you get.

You will get the same window as with the other method again, except that in this case the transponder
data has to be entered in the fields "Frequency”, "Polarity", "Symbol rate", "TS ID" and "Net ID".

In the field "Name" you can enter the name of the channel (here "Anem").
Then you have to enter the PIDs and the channel ID.

The TV channel "Anem" for example (see list above) has the video PID 4194 and the audio PID 4195.
The channel ID (service ID) is 1 and the PCR PID is as a rule identical to the video PID, so don't forget
to enter it!

For the Audio (radio) channels of course no Video PID is given. Usually you use the VPID 1FFF
(hexadecimal) or 8191 (decimal) to indicate that this PID is not used.

The PMT PID (Program Map Table) identifies and indicates the locations of the streams that make up
each service, and the location of the Program Clock Reference fields for a service.

If you don't find this PID, you can enter 1FFF (hexadecimal) or 8191 (decimal) instead, i.e. "not used".
For "normal" channels you don't need this PID.

In the field "Service Type" you can change the type of the channel (TV, radio or HDTV).

When you have entered all the parameters please click on OK and the new channel will appear at the
end of your channel list.

If you only want to change some of the parameters of a transponder (e.g. because the TS ID and/or
the Net ID are wrong), you simply have to select the transponder, click with the right mouse button into
the transponder list and select from the menu that appears the function "Change data". You get a
dialogue where you can change the parameters of the selected transponder. (You can also make a
double click on the transponder to get this dialogue.)

As soon as a satellite has one channel it is shown as being active (appears in green). Satellites that
have no channel have a white background. (You can change these colours in the configuration.)



Note: In some lists the PIDs are given in decimal notation, in others in hexadecimal notation (see
chapter 8). You have to be aware of that when you enter the PIDs. In the configuration menu and in
the channel data window you can specify if you want to see/enter the PIDs in decimal or hexadecimal
form.

Configuration
General setings | Colours | Corvert |
Frequ. Tol Column width
SHHz - 0% -
FIDs Cut names
decimal - End -
Langusge w
@ Englh £ ENMwkG Wagyar
" Deutsch " Slovensky " Tirkge
€ Mededands ~ C Gesky £ Morsk
¢ lisliann ¢ Pomugugs ¢ Romana
 Frangais £ Pycomui £ Suomalainen
" Swenska " Polski " Hrvatski
¢ Espafiol ¢ Dansk ¢ smski
£ Catalan
I~ Always on top
I~ Sttt with last used fle
I~ ‘When loading use personal sat seftings
¥ Restore last session when staring
I~ Show channel count in lists

When you enable the option "always on top" in the configuration menu, SetEdit21174 will always be in
the foreground on your desktop. This can be useful when you work with such Internet lists, as the
SetEdit window will not go into the background when you click in the browser.

You also change the notation of the PIDs if you click on the "H" for hexadecimal or "D" for decimal in
the border of the "Info" section.

To compare your settings file with lists in the Internet that are often sorted by frequencies you have the
possibility to sort the transponders of your settings file by frequency. To do this click with the right
mouse button in the transponder list and select "view sorted by" -> "frequency” from the menu you get.
Alternatively you can also view the transponder list sorted by polarity.

You can also set the viewing mode by clicking on the letters "O" (original), "F" (sort by frequency) and
"P" (sort by polarity) in the frame of the transponder list.

If you want to enter channels that differ only in few parameters, it is useful to create a duplicate of a
channel (please use the copy and paste function from the channel menu) and then change only the
different parameters.

For German Premiere it is often useful to have channel duplicates. For the sports channels you will
find different events (e.g. Champions league, Formula 1, etc.) on the main channels and "special
channels". Sport 1 is for example identical to a Formula 1 perspective and a Superdom (soccer)
channel. If you like to switch during a Formula 1 transmission between the different feeds it is useful to
have all these feeds in one block to prevent from skipping several channels. The same rules aim for
champions league and other events.

To create a channel duplicate please click on the channel you like to create a duplicate of, then open
the channel menu and select "copy" from this menu. Now select the desired position of the duplicate in
the channel list and select "paste” from the channel menu. The original channel and the pasted
channel are now marked red to show you that this is a duplicate channel. If you don't want to open the
channel menu every time you can also use shortcuts for these functions, Ctrl-C is for copy and Ctrl-V
is for paste.

There are two ways to find such a duplicate later:

When you move the mouse over a channel that is marked in red, you get a hint showing the number of
a channel that is a duplicate of this channel.

To find such a channel, first click on the channel list, then you can enter the channel number from the
keyboard, so if you hit the key "1" channel 1 will be selected, "1" + "4" will select channel 14 etc. As
with finding the channels by name, you have to enter the numbers within 3 seconds, otherwise the last
entered number is taken as the first digit.



You also have the possibility of using the "Find duplicates" function. Click with the right mouse button
in the channel list and select "Find duplicates" from the popup menu you get. You will see the following
window:

[ Find duplicates ===

R EE O Asis

AETRATHIRAAC
INICK/CC HD Austia— ASTRA TH,TKRLIL,
Bayen 1 ASTRATH,IKRIL,
Bayen 1 ASTRATHIRRAL,

[V Al satelites

I~ FIDs oK

All duplicates are shown. The different pairs of duplicates are marked in different colours. This function
does not distinguish between different types of channels, i.e. it can happen that you see a pair of TV
channel duplicates first and then a pair of radio channel duplicates. Relevant for this search are the
transponder data and the channel ID, but not the name. If you activate the option "PIDs", the video,
audio and PCR PIDs are compared too.

For the "Find duplicates" window there are the same functions as for the "Find channels" window, i.e.
you can delete and move channels from this window into another list and select if the duplicates are
searched on all satellites or only on the selected satellite.



3.h Import of channels

You have the possibility to get ready-made settings lists from the Internet. These lists can be used
partially or completely. You can find such lists for example at the following URLs: www.dxandy.com or
on the SatcoDX site (you can find a link on my homepage).

There are three possibilities to use such settings files. In this chapter you find a description how to add
some channels from an other settings file into your settings file.

The import function

You can import channels from all settings formats that are supported by SetEdit into your
SetEdit21174 settings. In the standard version you can import channels from SetEdit21174 settings,
DVB2000 settings, DXAndy and SatcoDX SDX files.

You can add other formats by copying the corresponding modules (SetEditXXX.dIl) into the SetEdit
directory (see chapter 2.)

Please click on "File" -> "New" and select the format of the settings file, from which you want to import
channels.

Open Ch+0 DEAndy Chrl+alt N+,
Last files b Medion 21174 Ctrlelt N+1
Clear last files list Grundig Chrlilt M+2
Fiead from receiver Ci+R Smart MAD4HD Cirl+ilt M+3

Toshiba ZL1 Clrlilt M+

Save Cil+5

A second window with the chosen settings file will be opened. In the same way you can open a third or
even more settings files. Each of these lists is equivalent. Every format (Medion 21174, DVB2000,
SatcoDX, DXAndy or other added formats) has its own symbol.

SatcoDX and DXAndy files are only Internet lists, so the functions "Read from receiver" and "Write into
receiver" do not exist for these formats.

Now you can easily transfer one or more channels by drag & drop from one window into another or
"Copy" and "Paste" them with the corresponding functions from the channel lists menu.

Note: As the Medion 21174 receivers only support digital channels you can't import analogue
channels. It may happen, that there are analogue channels for example in a SatcoDX file.

In the configuration of the SatcoDX settings file you can choose, if you only want to see analogue or
digital channels or both.

In the different settings formats there are different channel parameters. If a parameter only exists in
the destination list but not in the source list (e.g. there are no PMT PIDs in the SatcoDX files), a
standard value will be taken for this parameter.

You can also drag and drop groups of channels (for example entire transponder with all its channels)
from one window into another.

Source:
Channel list: The selected channels will be transferred.

All other lists (satellites, providers, labels, transponders, etc): All channels of the selected list will be
transferred.

Find window (e.g. "Find channels", "Find duplicates"): the selected channel will be transferred.
Destination:

Channel list: The imported channels will be pasted at the location the cursor is on at the moment you



paste the channels. Sometimes it is only possible to paste a channel, if a definitely assignment (e.g. to
a satellite) is possible in the destination list. In a SetEdit21174 settings list a satellite has to be
selected, if you want to paste a channel. If the entry "All" is selected in the satellite list, you can't import
channels from another window.

Transponder: A transponder is always definitely assigned to a satellite. So if you assign a channel
from another window to a transponder, these channels will be assigned to the satellite of this
transponder and will get the transponder data of this transponder.

If you drag and drop a transponder from one window into the transponder list of another window, this
transponder with all its channels will be added as a new transponder.

Note: If you import a transponder from another window, this transponder will be added to the satellite
that is selected. If "All" is selected in the satellite list, the new transponder will be added to the satellite
of the transponder the cursor is on.

If you drag and drop a satellite with all its channels to the transponder list of another window, all these
channels will be added to the transponder the cursor is on. This will also happen to channels that
come from another FAV list, provider, label, etc.

Note: It may happen that you can't receive a channel, if you assign it to the wrong transponder.

Satellite: The imported channels will be added to the satellite the cursor is on. Transponders that don't
exist yet in the transponder list of the destination settings file, will be created.

Favourite list: A direct import into the favourite lists is not possible.

General note: If there is a possible assignment, you can copy channels from each list of one window to
each list of another window. For example you can transfer channels from the "Find channels" function
of a SatcoDX list to a satellite of a Medion 21174 list.

In the popup menu of the channel list there are two functions that may help you to compare the
channel lists of different settings files. These functions are only available in the channel list menu, if
two or more SetEdit windows are opened.

With the function "Mark new channels in" you can mark in another window the channels that do not
exist in your actual list. (The channel number of these channels will be marked in green.)

Info Alt+l
Show 3
Wiew sorted by 3
Change data Return
Delete Del
Copy Chl+C
Paste Chrl+
Move to Crl+bd
Swap channels At

Select 3

Irvert selection Cirl+

Mark az 3
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Remove not existing channel markings
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Find duplicates Chrl+Dr
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If more than two lists are opened, you have to select in which list you want to mark the new channels.
If only two windows are opened, only one possibility is given.

With the function "Mark not existing channels in" you can mark in your actual list those channels (the



channel number will be marked in red) that do not exist in another window.

If more than two lists are opened, you have to select the channel list that you want to compare your
actual list with. If only two windows are opened, only one possibility is given.

With "Remove not existing channel markings" or "Remove new channel markings" you can remove the
corresponding markings. These functions will only appear in a channel list menu, if there are such
markings in the channel list.

If you have marked the "new channels" or the "not existing channels" in a channel list, you can select
them all.

Please click in the channel lists menu on select and choose the corresponding entry: "all not existing"
or "all new". This entry will only be shown in the menu, if there are such markings in the channel list.

Note: For the import of channels it is useful, to choose in the configuration the value 5 or even 10 MHz
for the frequency tolerance. It may happen that the frequency of the same channel differs just a little
bit in different lists. If the frequency tolerance is 0, these channels will be marked as "new" or "not
existing" too. But a difference of only some MHz is insignificant to the receiver, so you don't need to
import these channels.

Continue with Settings from other Receivers and how to convert a settings file.



3.i Settings from other receivers and how to convert a settings file

In the following you find a description how to transfer a settings file from a receiver of the same family
into your receiver or how to convert a settings file from another receiver supported by SetEdit into the
format you need, so you can write it into your receiver.

Settings files from other receivers of the same familiy

If you have got two receivers of the same family (e.g. two different receiver types of the same
manufacturer) and you want to transfer a settings file from one receiver into the other you may get
problems because in addition to the pure channel data also the satellite and LNB configuration and
some receiver identifications are included in the settings file. Many receivers only accept settings files
with their own receiver identifications. That is the reason why it is not so simple to exchange settings
files between two receivers even if the satellite and LNB configuration is the same.

So if you want to write a settings file from one receiver into another, you should first read once the
settings from the receiver, into which you want to write the settings file.

Then please save the satellite configuration for this file: click with the right mouse button into the
satellite list and select the function "save satellite configuration". Now your satellite and LNB
configuration is saved on your disc.

Open with "File" -> "Open" the settings file you want to write into the receiver. Then click with the right
mouse button into the satellite list and choose the function "load satellite configuration" to overwrite the
satellite configuration of this file with the satellite configuration you just saved.

Finally you can write the settings file into your receiver without any problems.

Example:
You want to write a settings file from receiver A into receiver B.
1. Read with "File" -> "Read from receiver" the settings from receiver B.

2. Click with the right mouse button into the satellite list and choose the function "Save satellite
configuration".

3. Load the settings file from receiver A with "File" -> "Open" in SetEdit.

4. Click with the right mouse button into the satellite list and choose the function "Load satellite
configuration”.

5. Write this settings file into receiver B with "File" -> "Write into receiver".

If you often take settings from the Internet but always want to keep your satellite settings, you can
enable the option "When loading use personal sat settings" in the configuration menu. Then this part
of the settings is always taken from your previously saved configuration.

Convert a settings file

You can convert all settings formats that are supported by SetEdit and for that you have got the
corresponding editor (in form of a DLL file) into the SetEdit21174 format.

In chapter 2 is described how you can add other SetEdit editors.



Please open with "File" -> "New" an additional editor window with the format of the file you wish to
convert.
Then please load with "File" -> "Open" the settings file you want to convert into another format.

You can only convert a settings file into the SetEdit21174 format, if you have already saved your
satellite configuration with the function "Save satellite configuration" in the popup menu of the satellite
list (see above). If you want to convert a SetEdit21174 settings file into another format, it depends on
this format, if you first have to save the satellite configuration for this format or if this is not necessary
(e.g. DVB2000, SatcoDX or DXAndy).

Important: If you convert a settings file only the pure channel and transponder data is taken
from the source settings file. The satellite and LNB configuration are taken from the satellite
configuration that has to be saved before (see above). If some channel parameters don't exist
in the source settings file, a default value is taken for this parameter.

Now you can convert the loaded settings file. To do this, please click on "File" -> "Convert to" and
select the format you want to convert this settings file to.
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Now you see the loaded settings file in the new format with the corresponding SetEdit version on your
screen.

Note: The different settings formats often contain different information, so you will always loose
information, when you convert a settings file. If you convert e.g. a SetEdit21174 settings file into the
SatcoDX format and back, you will see that all favourite channels are gone, because the SatcoDX
settings don't have favourite lists. If you convert a SatcoDX settings file into the SetEdit21174 format
and back, you will recognize, that all analogue channels have disappeared. The Medion 21174
receivers only support digital channels. In the same way it may happen that certain PIDs (e.g. the text
PID), volume information or the flags for "Scrambled” or "Locked" get lost.

In the configuration in the menu "Convert" you can enter the options that should be used, if you
convert into this format (see chapter 5.b).

If you want to convert another settings file into the SetEdit21174 format, you can for example sort the
channels by satellites or take the FAV lists from the source list. As the Medion 21174 receivers only
have one FAV list, all channels that were in any FAV list before, will be assigned to this favourite list.
If you want to convert a SetEdit21174 settings file into another format, you have to choose these
options in the configuration menu of this other format.

Continue with DXAndy settings.



3.j DXAndy settings

On the site www.dxandy.com you can download current settings for Astra, Hotbird and Turksat.

DXAndy settings are sorted by countries and you have many possibilities to adapt these settings to
your own requirements.

DXAndy settings contain all channels of Astra, Hotbird and Turksat and you can automatically adapt
them to the requirements of certain countries. In this case only the order but not the number of
channels will change.

You can hide whole groups of channels e.g. pay tv packages you don't need, call tv channels or even
all channels with one language.

You can hide channels you don't like permanently or add channels which are not included in DXAndy
settings.

You can easily convert such a individually adapted settings file into your SetEdit format.
In the following we describe all functions concerning DXAndy within an example.

Let's assume the following constellation:

- Astra, Hotbird and Hispasat (not included in DXAndy settings) can be received
- A German family with Spanish members

- The favourite regional "dritte" channel is "Bayerisches Fernsehen"

- German, Spanish and English channels

- No HD receiver

- Not interested in shopping-tv channels

- Pay-TV: Premiere without sports

- Not interested in erotic channels

- The channel 9Live is not wanted

Please open with "File" -> "New" -> "DXAndy" a DXAndy editor. With "File" -> "Open" you open a
DXAndy settings file.

If you click on "Config" in your DXAndy window, you notice that in the configuration the tab sheet
"DXAndy" has appeared. If you click on this tab sheet you will get three more tab sheets.

Sat and lists:

If you click on "Sat and lists" you get the following menu:
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With Satellites you can choose which satellites you can receive (Astra, Hotbird and/or Turksat). In the
channel list you only see channels of the selected satellites.

In our example you would select Astra and Hotbird. (How to add the Hispasat channels will be
described later.)

With Lists you can select a country specific order for your channel list. All lists contain the same
channels but the order differs. In the German list ARD and ZDF are at the first positions, for Austria
this would be the ORF channels, for Switzerland SF, ...

For our example you choose the list "Deutschland".

For Germany and Austria you can choose with Special channel which regional channel will be at the
third (Germany) or second (Austria) position in your channel list.

In our example this is "Bayerisches Fernsehen".

Furthermore there are 6 options you can choose:

Hide regional "dritte" channels: In Germany it is possible than the same regional channel may have
more than one regional "window" so you can find them several times in your channel list, e.g. WDR
Aachen, WDR Bielefeld, WDR Kaln, ... With this option you hide all channels of each regional group
except one. In the example WDR Aachen stays in the channel list, the others will be hidden.

Hide HDTV channels: All HDTV channels are hidden.

Hide Shopping-TV channels: All Shopping-TV channels are hidden.

Hide Call-TV channels: All Call-TV channels are hidden.

Insert dummy channel with list name: DXAndy files are originally sorted by FAV lists. If you convert
this settings file and this option is activated a dummy channel will be inserted at the beginning of each
channel group (FAYV list) with the name of this favourite list. For this function you have to disable in the
configuration of the destination format the option "Sort channel list by satellites".

Add personal FAV list: With this function you can automatically add a FAV list you have created with
another SetEdit editor and saved to your hard disc with the function "Export" of the favourite lists menu
of this editor. With the button "..." you can choose this FAV list. Now this FAV list will be added
automatically each time you load a new DXAndy file.

Note: In chapter 3.c you can read how to create such a "personal FAV list".

In our example you activate the options "Hide HDTV channels" and "Hide Shopping-TV channels".
Furthermore you choose the option "Add personal FAV list". With the button "..." you select the
favourite list with the Hispasat channels you have created with another Editor before.

Pay TV:

With "Pay TV" you get the following menu:
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Crypt systems: Here you can choose the crypt systems you can receive. The channels of the other
crypt systems will be hidden. With "Only FTA" all scrambled channels are hidden, only the "Free-To-
Air" channels stay in the channel list.

In our example you choose "Nagra" for the Premiere package.
You can hide these lists: With this function you can hide several channel groups, e.g. all Premiere
channels or all erotic channels. In this list you see all channel groups which either contain FTA

channels or are scrambled with one of the systems you have selected above.

In our example you choose "Erotic" to hide the erotic channels and then ORF, Digital+, ... to hide the
packages which are scrambled with Nagra too but for which you have no subscription.

Language:
If you click on "Language" you get the following menu:
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At the upper side of this menu you see for which language this file has been optimised, i.e. which
national list you have selected on the tab sheet "Sat and lists".
In our example this is German (GER).

Now you can choose if you would like to have channels with other languages in your channel list or
not. If not you will only have channels of the language group your list has been optimised for in your
channel list (In the example this is German).

If you activate this option, a box with "Additional languages" appears below. Here you can choose the
languages like to see channels with (channels with other languages will be hidden). With "Clear" all
language markers disappear, with "all" all languages are selected.



In our example you want to see (additional to the German channels) English and Spanish channels
too, i.e. you have to select "ENG" and "ESP".

If you click on "OK", your channel list will be actualised.

In our example you will see in the channel list all German FTA channels of Astra and Hotbird with
ARD, ZDF and Bayerisches Fernsehen at the first positions, the complete Premiere package and all
English and Spanish FTA channels. Erotic, Shopping-TV and HDTV channels are hidden. At the end
of the channel list you see the Hispasat channels you added.

Now you can hide certain channels or add certain channels or even add a complete channel group.

Hide channels:

If you mark a channel as "deleted" it will get the following symbol in the channel list: w

If you convert a DXAndy file into another format, all channels with this symbol will be removed from the
channel list.

Your SetEditDXAndy editor automatically saves, which channels you have marked as "deleted". l.e.
you only have to make this selection one time but can always download the current settings, convert
them and write them into your receiver.

In our example we want to hide the channel 9Live and the Premiere sport channels. Select these
channels in the channel list, click with the right mouse button in the channel list and select the function
"Mark as" -> "deleted".

Add channels/channel groups:

After you have converted the settings file you can add favourite lists you have saved to your hard disc
before with the "Import" function of the FAV-List menu (chapter 3.c) or you can choose in the DXAndy
configuration on the tab sheet "Sat and lists" a FAV list that will always be added (see above).

The channel list of a DXAndy file may contain gaps. l.e. empty channels have been added to make
sure that the position of first channel of each channel group has a round number.

With the function "Compact channel list" of the channel list menu you can remove these empty
channels.

Continue with Wish lists.



3.k Wish lists

With SetEdit you have the possibility to create a personal channel list, save this list as wish list and
then (if you have got the corresponding SetEdit full version) adapt any settings file to this wish list and
write it into your receiver.

This means the order of the channels will be taken from the wish list, unwanted channels and
transponders will be deleted and new channels can easily be added.

You can make a new channel research with your receiver whenever you want, read these settings
from your receiver and adapt them to your wish list. So you can be sure not to miss any new channels,
but you don't each time need to rearrange the channels, delete the same channels you don't want to
see or add channels (which e.g. haven't been found by the receiver because they were not active at
the time you made the channel research).

Create a wish list:

Please load any settings file in SetEdit (for example a settings file you just read from your receiver).

Now you start with moving the most important channels you know on the positions you want (for
example ARD on position 1, ZDF on position 2, ...).

Then you can mark channels you don't want to watch as "unwanted".

It's important to mark those channels as unwanted and not to delete them, because the wish list will be
used to delete these channels automatically from every new settings file. If you delete a channel, this
channel will appear again in your settings each time you make a new channel research with your
receiver.

The unwanted channels will stay in your settings file but will be shown with light grey font colour and
marked with a red minus symbol. So if you change you mind about a channel, you simply have to
remove the marking.

If you save a settings file or write it into the receiver, all unwanted channels or transponders are
deleted.

To mark one or more channels as unwanted there are three possibilities:

You can open the channel data window (double click on the channel) and click on "unwanted" there.
You can use the "mark as" function from the channel list menu or the shortcut "Strg-Alt-K" to mark one
or more selected channels as unwanted.

If you go through the channel list and realise that a transponder only contains channels you don't want
to watch, you have the possibility to mark the whole transponder and all its channels as "unwanted".

Note: If you mark a transponder as unwanted and than adapt a settings file so this wish list, all
channels of this transponder will automatically be marked as unwanted, even if they were new!

To do this you can double click on the transponder and then click on unwanted in the transponder data
window. But if you want to continue editing the channel list you have to click on "All" in the satellite list
and then scroll to the position in the channel list where you want to continue. So it's much easier to
select a channel of the transponder you want to mark as unwanted and then use the function "mark
as" -> "TP of this channel unwanted" of the channel list menu or use the shortcut "Strg-Alt-T".

You can mark channels which you always want to keep in your settings but which may not always be
found by the receiver (for example because they are not active all the time) as "extra" channels. These
channels will always be added when you adapt a settings file to your wish list.

You also have the possibility to link a channel with one or more alternative channels. To do this select
these channels and select the function "mark as" -> "linked" of the channel list menu. This means



when you adapt a settings file to this wish list and the first of the linked channels is not found, this
channel will be replaced by the next channel which is linked to it.

It is possible to link more then two channels. If you adapt a settings file to this wish list the first of the
linked channels that is found will be moved to the corresponding position in the channel list.

Example:

You have got a HD receiver and a "not HD" (SD) receiver. In your wish list you move the channel
arteHD on position 9 and mark the normal arte channel as unwanted. Then you link those two
channels.

So if you adapt a settings file from your HD receiver to this wish list and write it into this receiver, you
will find the channel arteHD on position 9 and arte (SD) will be deleted because it is marked as
unwanted.

If you adapt a settings file of the "not HD" receiver to this wish list and write it into this receiver, the
channel arteHD will not be found and so the alternative channel arte (SD) will be moved to position 9,
even though it had been marked as unwanted before.

So you only need to create one wish list, which you can use for both receivers.

With "mark as" -> "not linked" you can delete such a link.

Save a wish list:
If you have created your personal wish list you should save it.

Please click on the button "File" and choose the function "Save wish list". You get a window, where
you can enter a name for your wish list and choose where you want to save it. All wish lists get the
extension ".wish".

All channels, transponders and satellites are saved even if they are not wanted, extra or not found.

You have the possibility to save more than one wish list. This may be interesting if you have got more
than one receiver and if those receivers are used from different persons with different preferences.

Adapt a settings file to a wish list:

If you have saved a wish list you can now adapt any settings file (if you have got the corresponding
SetEdit full version) to this wish list and then write it into the receiver.

For example you make a channel research on the corresponding satellites with your receiver than you
read this settings file from your receiver and open it with SetEdit.

Now please click on the button "File" and choose the function "Adapt settings to a wish list". You get a
window where you can choose the wish list you want to adapt your settings to and click on "OK".

Now each channel of the wish list will be searched in the settings file.

Channels which are found appear in the channel list on the corresponding position. If a channel is not
found it also appears in the channel list but with a light grey font colour and marked with a red X.
Extra channels will always be added, if they are found or not. The unwanted channels are moved to
the end of the channel list, appear with light grey font colour and are marked with a minus symbol.
Channels which only appear in your settings file and which haven't been in the wish list before, will be
marked with an "N" as new channels. New channels also appear at the end of the channel list but
before the unwanted channels.

Note: If a new channel is found on a transponder which is marked as unwanted, this channel will

automatically be marked as "unwanted" and not as "new"!

Administer wish settings:

Now you can for example edit the "new" or "not found" channels.



With the shortcut "STRG-AIt-N" you get from your actual position in the channel list to the position of
the next "not found" or "new" channel.

With the shortcut "STRG-AIt-P" you move the actual selected channel to the first position of the new
channels. Then the next channel in the channel list will be selected.

With the shortcut "STRG-AIt-K" you can mark the actual selected channel as "unwanted", the next
channel in the channel list will be selected automatically.

With the shortcut "STRG-AIt-T" you can mark the transponder of the actual selected channel and all
other channels of this transponder as "unwanted".

Note: If you mark a transponder as unwanted and than adapt a settings file so this wish list, all
channels of this transponder will automatically be marked as unwanted, even if they were new!

If a channel is not found because it doesn't exist anymore or the frequency has changed, you can of
course delete this channel or replace it by the corresponding new channel (if the frequency has
changed).

If a channel is not found because of other reasons - for example because it isn't active all the time and
so it hasn't been found with the channel research of the receiver - you can either mark it as "Extra" or
you don't change it at all. If you save this file with "Save wish list" these channels will be saved too, but
without the marker for "not found". The markers for new channels will disappear too.

But if you save the settings file or write it into the receiver all "not found" or "unwanted" channels will
be deleted. All markers concerning the wish list functions will disappear too.

Write wish settings into the receiver:

If you have adapted a settings file to your wish list and if you have edited new or not found channels (if
there are any of them in your adapted settings file), you can finally write this settings file into your
receiver.

Please click on the button "File" and choose the function "Write into receiver".
You get a message. Please follow the instructions in this message to transfer the settings into your
receiver.

All "unwanted" channels and transponders and all "not found" channels which are not marked as
"Extra" channels will be deleted.



4 Program use and personal configuration

SetEdit21174 is mostly used with the mouse. You can also reach many functions with keyboard
shortcuts.
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On the main window you will find a group of buttons for the general functions ("File", "Config." and
"Help") and the lists that contain the transponders, satellites, the favourite list (FAV) and the channels.
If you hit the right mouse button in the satellite, transponder, favourite or one of the channel lists you
will get a popup menu with the specific functions for this list.

With "Help" you can open the help file, get some information about you SetEdit editor, open your
SetEdit directory or look for updates of SetEdit.
In some frames you find uppercase letters. If you click on these letters you can change some viewing

modes.

You can close every window that comes in SetEdit21174 (except the main window) with the Esc-key
on your keyboard.

In some lists you may find the following red symbols. These symbols indicate:

Scrambled channels
Skipped channels
Deleted channels
HD channels
DVB-S transponders (satellite)
DVB-S2 transponders (HD)
20 DVB-S2 transponders (Q-PSK)
528 DVB-S2 transponders (8-PSK)
- Unwanted channels (Wish lists)
Extra channels (Wish lists)
Not found channels (Wish lists)
M New channels (Wish lists)

== I

If a channel or transponder name is marked red there is a duplicate of this channel or transponder in
the settings.

Transponders marked in red are empty; they contain no channels.
TV channels appear in light blue, radio channels in light green.

If a channel or transponder is shown with light grey font colour, it's an unwanted or not found channel
or transponder (see chapter 3.k).



Channels that are in the FAV list are marked in the channel list with a darker background colour.

If the channel number is marked with a red background colour, the channel is assigned to a vertical
polarised transponder. If the channel number has a white background colour, the channel is assigned
to a horizontal polarised transponder.

If a satellite has a green background colour, it is activated, which means there are already channels on
this satellite.

When you select a channel, the transponder, the satellite and the favourite list (if the channel is in the
favourite list) are marked with a different colour.

You can change all colours in the configuration menu.

In the lower left corner you will find an "Information" section, where you see the parameters of a
selected transponder or channel.
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When you select a satellite in the satellite list only the transponders and channels that are in that
satellite are shown. When you click in a transponder or favourite list only the channels that are in this
list are shown.

You can adapt the design of SetEdit21174 to your personal wishes.

To change the size of the main window you can either click on the maximise button in the upper right
corner or drag one of the margins of the window.

If the main window is large enough, the channel lists can be shown in more than one column. Then
you have more channels in view. You can change the width of these columns in the configuration
menu on the tab sheet "General settings". In the section "Column width" you can enter if a new column
is created, when 100% (auto) or 90-30% of the channels are shown completely. The other channel
names are cut.
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With "manual" you can enter the column width by hand. Select the function "Setup column width" from
the menu of the channel lists and then you can click on the position where you want to have the right
border of the first column.

Note: There is a minimum width for the columns. If the window is too small to show more than one
column the column width has no effect.

In the section "Cut names" you can enter if the channel name is cut at the end,

Kbl 1.

or if a part of the channel name is cut from the middle.
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In the configuration on the tab sheet "General settings" you can change the menu language of SetEdit
(this concerns all opened SetEdit windows) and specify whether the PIDs are shown in decimal or
hexadecimal form (see chapter 8).



If you activate on the same tab sheet the option "Show channel count in lists" the number of channels
of each satellite, transponder and the FAV list is shown behind the name of this list.

Especially when you want to move channels from the beginning to the end of your list, it may be useful
to use the split function. With this function you can split your list into two parts, one showing the
beginning and the other showing the end of your settings (see chapter 3.b.)

With a double-click on the frame "TV channels" or "Radio channels" only the choosen channel list is
shown. With another double-click on this frame both lists are shown again. With the "show" function of
the menu of the channel list you have also the possibility to choose, if you only want to see the TV, the
radio channels, or both channel types.

You can also change the viewing mode of the PIDs, if you click on the letters "H" for hexadecimal or
"D" for decimal in the frame of the "Information" section.

For some functions you also have shortcuts for keyboard using:
Ctrl-O: Open a settings file

Ctrl-S: Save settings

Ctrl-R: Read settings from the receiver

Ctrl-W: Write settings into the receiver

Ctrl-P: Print settings

Ctrl-E: Export settings

Alt-R: Show only radio channels

Alt-T: Show only TV channels

To close a SetEdit window please click on the "close" button:
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or select "Close" from the "File" menu. If only one editor window is opened you close the complete
program.

If you select "Exit" from the "File" menu all open editor windows are closed. In the configuration you
can enter with "Restore last session when starting" that all opened editor windows are restored when
you start the program the next time.

When you like to use this function you have to finish from SetEdit with the "File" -> "Exit" function. If
you close all windows one by one only the last opened window will be restored.

Note: If you have unsaved changes you are asked if you want to exit or first save these changes.



5 Functions

5.a File functions

To get the file functions, please click on the "File" button. You will get the following popup menu:

N >
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Save wish list
Adapt settings to a wish list

Close
Exit

With New you can open another window of SetEdit with the same or another format, e.g. for the import
of channels or if you want to compare different channel lists (see chapter 3.h.)

With Open you can load settings from your disc.
With Last files you get a list of the 10 last used files, which you can load.
With Clear last files list you can remove all entries from the last files list.

Read from receiver: You get a message which describes how to transfer your settings from your
receiver into your PC.

With Save or Save as you can save the current settings to your disc.

With Write into receiver you can transfer the settings from SetEdit21174 to your receiver. You also
get a message. Please follow the instructions in this message.

With Convert to you can convert your actual loaded settings file into another settings format (e.g.
SatcoDX). If you want to convert another settings format (e.g. SatcoDX) into the SetEdit21174 format
you first have to open a new editor window (with File -> New) with the corresponding SetEdit format
(e.g. SatcoDX) and then you can load the Settings file you want to convert in this editor window. To do
this you first have to save your satellite configuration (see chapter 3.i).

With Print you can print your settings (see chapter 3.f).

With Export you can export your settings as an ASCI! file (e.g. to open it with Word). You have the
same options as with the print function.

With Save wish list you can save the actually loaded settings file as a wish list (see chapter 3.k).

With Adapt settings to a wish list you can adapt an actually loaded settings file to a previously saved
wish list (see chapter 3.k).

With Close you close the actual active SetEdit window. If only one window is opened you close the
complete program.

With Exit you exit from SetEdit. All open editor windows are closed. In the configuration you can enter
with Restore last session when starting that all opened editor windows are reopened when you start
the program the next time.

When you like to use this function you have to finish from SetEdit with the "File" -> "Exit" function. If
you close all windows one by one only the last opened window will be restored.



5.b Configuration

Click on the "Config." button to change the general settings of SetEdit. There are three tab sheets in
the configuration menu.

General settings:

If you click on "General settings" you get the following menu:

The value Frequ. Tol. (Frequency tolerance) is used when importing and indicates the tolerance a
transponder frequency may have relative to the imported one to be considered to be the same. If you
have for example a transponder with the frequency 11721 MHz in you settings and you import a
channel with the frequency 11720 MHz and the frequency tolerance is set to 5 MHz no new
transponder is created. This tolerance is also used for the transponder list.

With Column width you can select if 100% (auto) or 90-30% of all channels have to fit completely to a
column. All other channel names are truncated. With "manual" you can enter the column width by
hand. Please select the function "Setup column width" from the menu of the channel lists and then you
can click on the position where you want to have the right border of the first column.

Note: There is a minimum width for the columns. If the window is too small to show more than one
column the column width has no effect.

In the field Cut names you can enter, if channel names that are too long (see column width), are cut at
the end or in the middle.

In the field PIDs you select how the PIDs are shown/entered (decimal or hexadecimal). You can also
switch between these two viewing modes, if you click on the "H" for hexadecimal or the "D" for decimal
in the frame of the "Information" section.

With Language you can select the menu language you would like. This language is taken for all
opened SetEdit windows.

With Always on top SetEdit21174 always stays on top of your desktop.

With Start with last used file SetEdit21174 opens automatically the last used file every time you start
the program.

With When loading use personal sat settings you can, after you have once saved your satellite
configuration (see chapter 3.i), use this configuration automatically when loading settings. For example
you can use your satellite settings always when you load settings from other sources.

If Restore last session when starting is activated, all editor windows that were opened when you
closed the last session are reopened (see chapter 5.a.)

If you activate Show channel count in lists the number of channels of each satellite, transponder
and the favourite list is shown behind the name of these lists.



Colours:

If you click on the tab sheet "Colours", you will get the following menu:

éI

rrrrrrrr

Here you can change the colours that are used to mark the following states:

Activated (programmed) satellites

7.0%¢ Milezat
19.2°E Astra
28.2°E AsztraZ

Horizontal polarised transponders, vertical polarised transponders

118 SPORTMANIA
119 [OF. TRIUWFO
120 Evrogpart
121 Formula 1

TV channels and radio channels

200 Canal Cocina
2M CCWalenciana
202 Cadena Dial
203 M-80 Radio

TV or radio channels that are in the favourite list

h82 GOURMET TV
A83 AJARA TV
534 TAMIL Radio
A85 RB.Rinazcente

Transponder, satellite and FAYV list of an actually selected channel (Active Tr/Sat/FAV)

12538 H 27500 344
12558 W 27500 344
12595 % 27500 344

Channel duplicates

574 ARIAANG TY

575 Ch-3 Arabic [BA TY
576 R.R FEED

577 BE TV

Empty transponders

‘-1 1070H 7199
~11080 % 563

New or not existing channels (for the import function, see chapter 3.h)



37 MTAINTL

318 W0 CH

19 RTLZ AUSTRIA
320 ZDF

The icons for e.g. "skipped", "scrambled", "deleted", "HD" or for the different transponder types.

114 JUMIOR
115 K-TOOM 4
116 PRERI.. Austna

With a double click on the frame of a colour field, you get the default colour again.

"Hadiu \

Convert:

On the tab sheet "Convert" you can choose which options should be used, if you convert another
settings file into the SetEdit21174 format.

Sort channel list by satellites: The channels of the source list will be sorted by satellites, when you
convert into the Medion 21174 format.

Convert labels to FAV lists: The first one labels of the source list will be converted to FAV lists.

Convert providers to FAV lists: The first one providers of the source list will be converted to FAV
lists.

Convert FAV lists to satellites: All FAV lists of the source list will be converted to satellites.

Note: If you want to use this function it is important that each FAV list of the source list only contains
channels of one satellite.

To make a satellite empty there is the function "clear" in the satellite menu (see chapter 5.d.)

This option may be useful for example if the source list has more FAV lists as you can have in your
SetEdit21174 settings and you want to keep all of them.

Take FAV list(s) from source list: All FAV lists will be taken from the source list. As the Medion
21174 receivers only have one FAV list, all channels that were in any FAV list before, will be assigned
to this favourite list.

If you want to convert a SetEdit21174 settings file into another format, you have to choose these
options in the configuration menu of this other format. Depending on the receiver there can be up to 10
different options.



5.c¢ Channel functions

Please select the channels you like to edit/modify.

You get most functions when you click with the right mouse button on a channel list. You will get the
popup menu of the channel list:

Into Alt+
Show 3

View sorted by »
Change data Retum
Delate Del
Copy Cul+C
Paste Chil+
Move to Cul+b

Swiap channels Al
Select 3
Irivert selection Ctrl+|

Mark as 3
Mark new channels in »
Riemove new channel markings

Mark not existing charnels in »
Remove not existing channel markings

Sort »
Compact channel list

DISMEY CHANNEL -> Disniey Channel Al
Find channels CilsF
Find duplicates ChkD

New CtrlsM

v Spiit Ctrl+T
Some menu items are only visible, when you are using the import functions.

Info: Here you get the number of TV and radio channels, transponders and satellites that are in your
settings.

With Show you can change the viewing mode of SetEdit21174. You can select if you only want to see
the TV or the radio channels or both.

Note: Alternatively you can double-click on the TV/Radio frame to change the viewing mode.

Furthermore you can hide the satellites, transponders, the favourite list and the data window with
Show only channels. With All lists you can see all lists again.

With View sorted by the channel list can be shown in the original order, sorted alphabetically or
sorted by frequencies or polarities.

With Change channel data you get the following window where you can change the properties of a
channel:

| dat:
ServiceType Net 1D
L2 [Tv =l
PCR FID Frequency TS ID
[1o1 [330.000 [1051
Viden PID—-Audio PID
10 02 -
PMT PID PiDs Symbal rate
[100 [Dec -] | [Bo00
[~ serambled
I~ skipped
[~ deleted
I~ HD
™ exr
[ unwanted
Cancel oK

In the field Name you can change the name of the channel.

You can enter the PIDs, the Channel ID (Service ID), the Service Type (TV, radio or HDTV channel)
and the transponder data of the channel and enter, if the channel is deleted, scrambled or marked
as skipped.

With PIDs you can choose if the PIDs are shown decimal or hexadecimal.



Note: For some transponder types certain channel data boxes will disappear, e.g. DVB-C and DVB-T
transponders have no polarity.

You can find a longer description of the different PIDs, IDs and transponder data in chapter 3.g.

With Delete you can delete selected channels or, when you are in the FAV list, remove them from this
favourite list.

You can also delete one or more selected channels by hitting the Del key on your keyboard.

With Copy you can copy a channel, then you can paste the channel to another position.

With Paste you can paste a channel that was previously deleted or copied.

With Move to you can move a channel to a position that you enter with the keyboard.

With Swap channels you can swap two selected channel. You can only select this function when
there are exactly two channels selected in the channel list.

With Select you can select all, all scrambled, all skipped, all deleted, all HD channels, all C-band
channels, all Extra channels, all unwanted channels or (for the import) all new or all not existing
channels (depending on which channels are actually marked).

Select all Chrl+a
Inwert selection Cirl+l all scrambled
all FTa

Mark az 2 (o]
Mark new channels in p| 8 sKibRe

. all deleted
Femave new channel markings

. . all C-band channels

tark not existing channels in 3

Remave nat existing channel markings
Sort J
Compact channel list

DISNEY CHANMEL -> Disney Channel Al

all FAY channels
all HD channels

all Extra channels

all urwanted channels

With Invert selection you can invert the selection, the channels that are selected will become
unselected and vice versa. If you like to delete all but one channel from a transponder, you can select
the channel you like to keep, invert your selection and delete the now selected channels.

With Mark as you can change the following properties for one or more selected channels at once:
-Mark channel(s) as "(not) skipped", "(not) deleted" or "(un)scrambled"

-Assign channel(s) to a service type

-Assign channel(s) to the FAV list or remove it/them from the FAV list

-Mark channel(s) as "(not) linked", "(not) unwanted" or "(not) extra" (wish lists)
-Mark the transponders or the selected channels with all their channels as unwanted (wish lists)

Mark new channels in ]
Remave new channel markings

sorambled
unzcrambled
skipped

Mark not existing channels in 3 ot skipped
Remaove nat existing channel markings deleted Alt+Del
Sort b ot deleted Shift+Alt+Del
Compact channel list Fi& channel
DISMEY CHANMEL -» Disney Channel Al na FAY channel
Find channeks: Cil+F Iinketd
Fird duplicates T | et lnked
New Cun | Font g
Service type »
w Split Chil+T
exhia
ot extra
urwanted Chilat+K
ot unwanted Shift+Alk+k,
TP af thiz channel unwanted Chrl+alt+T

Mark new channels in: If you have opened more than one window of SetEdit (Import), you can mark
in another channel list the channels that you don't have in your actual channel list.

Mark not existing channels in: If you have opened more than one window of SetEdit (Import), you
can mark in your actual channel list the channels that you don't have in another channel list.



Remove new/not existing channel markings: With this function you can remove the markings for
new or not existing channels in your actual list (Import).

With Sort you can sort selected channels by alphabet, by frequency or by polarity or sort the entire
channel list by satellites.

Sort by alphabet
Compact channel list Sort by friequency
DISNEY CHANMEL -» Disney Channel Al Sort by Service 1D

Find channeks: Ctil+F Sort by palarity

Find duplicates kD Sort channel list by S atellites

With DISNEY CHANNEL -> Disney Channel you can change the names of the selected channels
from upper case to lower case. Uppercase letters are usually wider than lower case letters, so this
allows you to see more characters of the name in the channel list of the receiver. Only words with
more than 3 characters are converted. If there are both upper and lower case letters in the channel
name the word is not converted (e.g. EuroSport stays as it is). In the configuration file of SetEdit21174
(SetEdit.ini) there is a list of up to 10 words that are converted although they are shorter than 4 letters
(CO, INT, FOX) and a list of words that are not converted although they are longer than 3 letters
(CNBC, ESPN).

With Find channels you can find channels by name.
With Find duplicates you can look for channel duplicates.
With New you can create a new channel.

With the Split function you can tile the TV and radio list in two parts. It is the same list but from two
points of view. Changes in one list also affect of course the second list. You can move a channel from
the upper to the lower list of course.

The function Setup column width is only visible in this menu, when you have entered "manual” in the
section "Column width" in the configuration menu (see chapter 5.b). With this function you can enter
the column width by hand. Please select this function and then you can click on the position where you
want to have the right border of the first column.

Note: There is a minimum width for the columns. If the window is too small to show more than one
column the column width has no effect.

To move channels you simply drag them with the mouse to the position where you want them to be (if
you reach the border of a list the list will scroll automatically).

To assign one or more channels to a satellite, transponder or the favourite list drag it/them with the
mouse to the name of the satellite, transponder or favourite list.

To see all channels of a satellite, transponder or the favourite list, please click in the respective list on
the corresponding entry.

In the frame of the channel list there are several uppercase letters for the following functions:

A: The channels and the satellites, transponders, FAV list and the data window are shown.
C: Only the channels are shown.

O: The channels are shown in original order.

N: The channels are shown in alphabetical order.

F: The channels are shown sorted by frequencies.

P: The channels are shown sorted by polarities.



5.d Satellite functions

When you click on a satellite only the channels and transponders of this satellite are shown.

When you click with the right mouse button in the satellite window you will get the following popup
menu:

Show active satelites

Change data Retum
View sorted by L2 w Driginal Al+0
Sort »|  Mames [alphabetic) Alteh
Hotbird -» 12.0E Hotbird Longitude AltsL
New Crl+M

Delete Del

Clear Alt+Del

Save satelite configuration

Load satellits configuration

Show active satellites/Show all satellites:
With this function you can select if you want to see all satellites in the satellite list or only the active
satellites (satellites which already have channels).

Change data:
You will get the following window in which you can change the satellite-specific data:

Change data (=3

LOF love [usert 1 LOF high [user}
5750 [0
Longitude: DiSEqC:

19.2E 1

DiSEQC 1.1 Toneburst

Off hd off -

Cancel oK

You can also double-click on the satellite to get this.

Here you can change the Name, the geographical position (longitude), the LNB configuration,
and the parameters for the DISEqC and the Toneburst of this satellite.

View sorted by:
With this function you can select if the satellites are shown in original order, or sorted alphabetically
or by the geographical position (longitude).

Sort:
With this function you can sort the whole satellite list alphabetically or by their Longitudes.

Hotbird -> 13.0E Hotbird:
This function adds the geographical position at the beginning of the name of each satellite.

With Clear you can clear a satellite. All channels and transponders are deleted and the geographic
position is set to 0.0° east. This is useful if you want to use the convert option "Convert FAV lists to
satellites" (see chapter 5.b).

With New you can enter a new satellite.

With Delete you can delete a satellite and all transponders and channels that used this satellite.
Save satellite configuration:

With this function you save the satellite and LNB configuration of the actual loaded settings file (see

chapter 3.i.)

Load satellite configuration:



With this function you can overwrite the satellite and LNB configuration of the actual settings with a

configuration you saved before. In the configuration menu you can enter that this is done automatically
when you load a file.

In the frame of the satellite list there are several uppercase letters for the following functions:

A: Show all satellites

P: Show only active (programmed) satellites

O: Show satellites in original order

N: Show satellites sorted by alphabet (names)

L: Show satellites sorted by their geographical position (longitude)



5.e Transponder functions

If you select a transponder only the channels that belong to this transponder are shown.

If you select "All" in the satellite list you can move the mouse over a transponder to see the satellite of
this transponder.

You get most functions if you click with the right mouse button on the transponder list. You will get the
popup menu of the transponder list.

ew sorted by 3 v Original Shift+At+0
Sort 3 Frequency Shift+alt+F
Change data Fietum Folarity Shift+at+P
Delete Del

Delete all empty transponders

Delete all MCPC transponders (symbal rate » 10000)

Delete all SCPC transponders [symbal rate < 10000)

New 3

With View sorted by you can select if the transponders are displayed in their original order or sorted
by frequency or polarity. The transponders will remain in the original order internally.

With Sort you can sort the transponder list by frequencies or polarities. With this function you also
change the internal order off the transponders.

With Change data you can change the parameters of a selected transponder. You get the following
window:

Change transponder data
Frequency Met ID
24E.000) E1441

TSID

10015
Symbol rate
S5 Cancel

]

[~ urwanted

You can also call this function with a double-click on a transponder. Here you can change the
frequency, the polarity, the symbol rate, the Net ID and the TS ID of a transponder.

If you mark a transponder as unwanted, the transponder and all its channels will be shown with light
grey font in the corresponding list and will be marked with a red minus.

Caution: If you save a settings file, all unwanted channels and transponders are deleted.

You need these markings for the wish lists functions (see chapter 3.k).

These changes are made for all channels that use this transponder too.

With Delete you can delete a transponder and all its channels. You can also use the Del key on your
keyboard. If the transponder has channels, you are asked if you really want to delete these channels.
If you want to delete a transponder without checking if existing channels are deleted too, you can use
the shortcut Ctrl-Del.

With Delete all empty transponders you can delete all transponders that don't contain channels.

With New you can create a new transponder or a new TV or Radio channel on the selected
transponder.

If you want to create a new transponder, and a satellite is selected in the satellite list, the transponder



is assigned to this satellite. If "All" is selected in the satellite list and a transponder is selected in the
transponder list, the new transponder is assigned to the satellite of this selected transponder. If "All" is
selected in the satellite list and no transponder is selected, you can't create a new transponder.

11070 H 7199 22
-11080 Y 563 3

The red letters and numbers specify the transponder type: S for DVB-S, S2 for DVB-S2, S28 for DVB-
S2 in 8-PSK, S2Q for DVB-S2 in QPSK, C for DVB-C (cabel) and T for DVB-T (terrestrial).

If you select a transponder a little dot appears in front of this transponder and of all transponders with
the same satellite.

Transponder marked in red are empty; they contain no channels.

If a transponder name is marked red there is a duplicate of this transponder in the settings.

In the frame of the transponder list there are several uppercase letters for the following functions:
O: The transponders are shown in original order.

F: The transponders are shown sorted by frequencies.
P: The transponders are shown sorted by polarities.



5.f Favourites

The Medion 21174 receivers have one favourite list into which you can copy your favourite channels.

L R R 1.

Fay
[Fi

When you click with the right mouse button in the favourite list, you get the following menu:

Change name: Fietum
Clear

Adapt main list to FAY list

Export

Import
With Export you can save a selected FAV list.
With Import you can load a previously saved FAV list.

Channels that are in the FAV list are marked in the channel list with a darker background colour.
(You can change these colours in the configuration.)

Add/remove a channel to/from the FAV list:

To add one or more channels to the FAV list, please select the channel(s) you want to add to the FAV
list. Now you can drag them to the FAV list (drop them on the name of the list). They are added at the
end of this FAV list.

To remove a channel from the FAYV list, please select the FAV list and then the channel that you want
to remove from the favourite list and use the delete function of the channel list menu or hit the Del key
on your keyboard. If you delete a channel within the FAV list, this channel is only removed from the
FAV list and not from the main list.

It is also possible to assign one or more channel(s) to the FAV list or remove them from the FAV list
with the help of the "Mark as" function in the channel list menu.

You can't change the order of the channels in the FAV list independent of the order of the channels in
the main list.

To change the name of a FAV list please make a double click on the FAV name, you will get the
following window:

Warme Endem Eingabe
Leeren

Hauptliste an Favoritenliste anpassen

Export

Here you can enter the name of the FAV list.
Note: It is not possible to change the name of the FAV list; it is hard coded in the receiver.

You can easily change the order of the FAV-lists by drag & drop.

Continue with FAQ.



6. FAQ

What do | need to transfer the settings from the receiver to the PC and back?
You need an USB stick/drive.
Why is it not possible to convert into the SetEdit21174 format?

It is only possible to convert another settings file into the SetEdit21174 format, if you have saved the
satellite configuration before (see chapter 3.i).

I have got two receivers of the same family, how can I load the settings from one receiver into
the other?

You want to write a settings file from receiver A into receiver B.
1. Read with "File" -> "Read from receiver" the settings from receiver B.

2. Click with the right mouse button into the satellite list and choose the function "Save satellite
configuration".

3. Load the settings file from receiver A with "File" -> "Open" in SetEdit.

4. Click with the right mouse button into the satellite list and choose the function "Load satellite
configuration”.

5. Write this settings file into receiver B with "File" -> "Write into receiver".

You can read chapter 3.i for more details.

How can | add the same list with my favourite channels to different settings lists?

Please create a favourite list with these channels and save this list to your hard disc with the export
function of the favourite lists menu. Then you can insert this list in every settings file you want with the

import function of the same menu (see chapter 3.c).

| have registered SetEditTopfield5000 and | want to create settings for my Humax receiver. Why
do | always get the message "Unregistered demo version" when | start the program?

You have to register SetEdit for every receiver separately.

| registered version 1.00, but on the homepage | found the version 1.05 Do | have to buy a new
registration key?

No, you don't have to buy a new registration key. Just download the upgrade from the site
www.setedit.de and install this upgrade in your already existing SetEdit directory.

| want to write Humax settings into my Topfield receiver. How can | do this?

Load the Humax settings into the corresponding SetEdit editor and convert them with File -> Convert
to -> Topfield into the format you need for your Topfield receiver. Now you can write these settings into
your Topfield receiver (see chapter 3.i).

I want to write Humax settings into my Topfield receiver. Do | have to register both versions?

You only have to register the version you need to write into the receiver. In the example this is the
Topfield editor.

When | read from the receiver | get the message "Error loading file".



Maybe the transfer has failed, please try again. If you still get this error message, please send me the
file SetEditxxxRead.logc (to Wolfgang.Litzinger@setedit.de). You find this file in your SetEdit directory.

How do | find my SetEdit directory?

If you don't remember where you have installed SetEdit, please click on the Help button and choose
the function "Show SetEdit directory". A window with your SetEdit directory will be opened.

How can | watch scrambled channels?

You have to buy the corresponding pay-tv subscription!

Where do | enter the keys for the emu?

This is not possible. You have to buy the corresponding pay-tv subscription!
Does SetEdit work with a patched receiver software?

SetEdit21174 is only tested with the original version of the receiver firmware. If you have changed the
receiver firmware, | can't guarantee that the program will work properly.

I would like to make a channel search on position 28.2° E with my receiver. How can I find out
which satellite | have to choose?

Please click with your right mouse button in the satellite list and choose the function "Hotbird -> 13.0E
Hotbird". The position of each satellite will be added at the beginning of each satellite name. Now -
after writing these settings into your receiver - you can easily find the right satellite.

How can | add another receiver?

1. Select on my homepage the receiver you want to add.

2. Download the upgrade (zip file).

3. Extract the zip file and enter the directory of your SetEdit installation as destination directory.

4. Close all SetEdit editors and restart the program.

You can read chapter 2 for more details.

| have started SetEdit two times and want to copy channels from one window into the other.
Why is this impossible?

You have to start SetEdit only once and then open with File -> New a second editor window. Now you
can easily drag and drop channels from one window into the other.

SetEdit is hanging, | can't do anything.

Sometimes it may happen that an error message or a dialog window is hidden behind the main
window. With the short cut Alt-Esc you can bring it in the foreground.

Where can | get help if | have other problems?

If you have any other problems please feel free to contact me by e-mail. Please note for all problems
the exact version of SetEdit you use (see Help -> About SetEdit21174).

My e-mail address is Wolfgang.Litzinger@setedit.de

Please don't call me to tell me about problems. There is ho phone support.



7 Register

You can get your registration key for 29,99 € from me. | need your full name and your e-mail address. |
can't send you the registration key by post.

In the demo version you can only change 20 channels. After this you can neither save your settings
nor write them into your receiver.

Note: Without your e-mail address and your full name | can’'t register you for SetEdit21174.
To register for SetEdit21174 there are 3 possibilities:
1. You send me the money in cash (by registered letter).

My address is:

Wolfgang Litzinger
Frontalstr. 42

67693 Fischbach/Germany

2. You can make a direct money transfer.

Note: If you transfer from outside Germany please make sure that you pay the fees for international
money transfer.

My account is:

Account number 44 609 52 00

Bank name: Bank 24

Sort code: 380 707 24

Bank address:

P.O. box 24

Karl-Legien Str. 188

53244 Bonn/Germany

SWIFT: DEUT DEDB XXX

IBAN: DE66 3807 0724 0446 0952 00

Please use as the reason for payment your name, the editor version you wish to order and add a
random number (e.g. your zip code, phone number etc.).
Example for a reason for payment: Charles Brown SetEdit21174 12:56

Please send me an e-mail when you have transferred the money. The body of the mail should contain
your name, the editor version you wish to order (here SetEdit21174) and the random number you
wrote in the reason for the money transfer.

Example for an e-mail text: Order for SetEdit21174, Charles Brown, 12:56

Please check if you e-mail address is valid (e.g. by sending an e-mail to your own address).
Unfortunately it happens sometimes that | want to send someone an e-mail with the registration key
but the e-mail comes back undeliverable because the return address is not correct.

Please make sure that your name is in the e-mail (there are often e-mails like "from:
superman@aol.com, | have sent you money today please sent me the editor"). In this case | can't
relate your mail with my bank account.

Please don't try to write your e-mail address to the reason of the money transfer, special characters
like "@" and "_" are not valid for this.

Please don't sent me pictures of your transfer sheet or online banking program, you will get the
key as soon as | have the money on my bank account, | check my account every day.

If you get no e-mail from me after 7 working days, please contact me by e-mail. Either | could not
assign your money transfer to someone or something is wrong with your e-mail address.



3. You can also use the online shop on my homepage to pay by Visa/MasterCard or PayPal.

Back to Contents.



8 Glossary and abbreviations

Baud rate: The speed at which data is transferred via the serial port to the receiver. The number is in
bits per seconds.

Decimal/Hexadecimal: Hexadecimal is a system for representing numbers in base 16, rather than the
base 10 we normally use. The hexadecimal system requires 15 digits and a zero; conventionally the
letters A-F are used to represent the digits for that the decimal system cannot provide equivalents.
Hexadecimal notation is not usually important for the PC user (with the possible exception of
specifying base addresses) but is still quite important for the programmer. Its importance arises
because there is a very close correspondence between hexadecimal and the very important binary
numbering system that computers use internally. However, hexadecimal notation is much more
compact than binary.

The reason why you can select both systems in SetEdit is that many satellite operators use "even"
hexadecimal PID numbers. For example the audio PIDs on Astra transponder 11720 are in decimal
notation 256, 512, 768, 1024, 1280 etc., whereas in hexadecimal notation they are 100, 200, 300, 400
etc.

DLL: Dynamic Link Library. A Windows library file that can be shared by multiple applications.

FEC: Forward Error Correction. A system, in which redundancy is added to the message so that most
errors can be corrected dynamically at the receiver. Usual values are 1/1, 1/2, 2/3, 3/4, 5/6 and 7/8.
3/4 means that 3 out of 4 bits are reference data and the remaining one is for error correction.

LNB: Low Noise Block (converter). Amplifies received signals and converts them from microwave to
lower frequency signals that are then sent along a cable to the satellite receiver. An LNB can be either
single or double. A double LNB is required when more than one receiver is used allowing the viewing
of different satellite channels on other television sets.

PID: Program Identifier. A 13-bit code in the transport packet header. PID 0 indicates that the packet
contains a PAT PID. PID 1 indicates a packet that contains CAT. The PID 8191 (all 1 bits) indicates
null (stuffing) packets. All packets belonging to the same elementary data stream have the same PID.
The most important PIDs are the Video PID (for the video information), the Audio PID for the sound
and the PCR PID (Program clock reference) to get Video and audio synchronous.

If you enter an existing Service ID for a channel, the receiver can get all necessary information for this
channel. If you only enter the video and the audio PID, it may happen that you see the picture and
hear the sound, but EPG does not work because this information is transmitted on a different PID.
Usually the receiver finds the PIDs automatically, but occasionally (exotic channels) you have to know
them and enter them by hand.

Symbol rate: The amount of digital data that is transmitted per second via a transponder. This is
specified in Msymb/sec (Mega symbols per second), whereby a "Symbol" consists of 4 bits. The
symbol rate together with the FEC value can be used to calculate the bandwidth of a transponder.

Polarity: A satellite transmission signal has either a vertical, horizontal, or circular orientation; a
satellite can be all vertical or all horizontal; if a satellite is cross polarised, it can transmit both ways
and therefore has twice the delivery capacity.

Besides the horizontal and vertical polarisation we also find the circular polarisation. Circular
polarisation is not as easy to understand as linear polarisation, you can imagine that the waves are
rotating clockwise or anticlockwise. In this case we speak about LHC and RHC (left hand circular and
right hand circular).

As a rule in Europe linear polarisation (horizontal and vertical) is used. In Scandinavia and for C-band
reception circular polarisation is used.

Select: To select a channel please click with the mouse on the channel. To select more than one
channel you can use the usual windows methods.

When you press the shift key and click on a channel all channels between the currently selected and
the last selected channel are selected.

If you press the Ctrl key on the keyboard you can add single channels to your selection.



Settings are the part of the memory of your receiver where all channel information is stored.
It contains all channel information such as sequence, channel name, frequency, symbol rate, FEC,
and all other parameters.



